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1. R FEWREHRA 15-30°C2 8, REA 15-80 % . wRIEZE. B EF ki 2|
BR, FHAEE. BRENREMMN KRS, HELBNERFFELR,

2. Ella 5% 37cm, ¥ 54cm, & 26cm, F 16kg. A BN AN £ W T 5, RE, HFMik
BB QLR I DU IR B LA

3. WMZEINFENT &Ko

Description Specification

Environmental Conditions For Indoor Use Only

Altitude up to 2000 m (6600 ft)

Temperature Range: 15°to 30° C (59° to 86° F)
Humidity: 15 to 80% RH, non-condensing
Rated Pollution Degree: Degree 2

Electrical Ratings 100-240 V(AC), 300 VA, 45/65 Hz, Class |
Installation Category (Qver Voltage) Il

Flectrical Test Specifications CB Scheme:
IEC61010-1:2010
Supplemented by IEC 60825-1:2014

TOV SUD “CUE" Scheme:
CAN/CSA-C22.2 No. 61010-1:2012
UL &1010-1:2012
EN61010-1:2010

EN 60825-1:2014

Physical Conditions Overall dimensions:
37.cm (w) x 54 cm (d) x 26 cm (h)
146in(w)x21.3in(d) x 10.2 in (h)

Weight: 16 kg (35.3 Ib)

Laser Test Specifications Class 1 Laser Product according to IEC 60825-1:2014
and EN 60825-1:2014

Complies with FDA performance standards for laser
products 21 CFR 1040.10 and 1040.11 except for devia-
tions pursuant to Laser Notice No. 50, dated June 24,
2007,

External Fusing Main fuse (appliance inlet): 4 A, 250 V; IEC 60127 rated
as T4AL 250V

Table 1-1: Specifications
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L RKHFEN, BFE, B2k,

2. HElQMRNETTEFARER, RATAEIRECETRECFEL, REF
£, RHAOEFE, WTHENPVC R EHZEFEHNEELER.

3. BREFEHBANRNE, £l Ella 2EAF, WwRAWEMZ LM, A HE
P& T, LL# PR Ella & F.

4. WHATH EE L#y “Runner” BAE, 5 Tools>Self-Test, 41 B # tE4E
J&, F Scanner HE R EFEH T W %4, KFFemID.

5. i StartzA7 B4, KAFHH 45 4. WRUBATRIVRS, THELZ#TH
ﬁ — R R AR R IR EAT B R s B A BIATEAR— R T .

6. ERmAERNLERT, EREFEREY, WEPVCHE, RHEAXEYZEREGE
BEOL), 4L A, S£HATEY LR Passed 77 i #4T F 4 Lo

7. WEARKY, HERARE, NEfEN, KERIR. B 3504 EHFN, EM
1-2 %, &4 3RHxE, FH AP I Z Proteinsimple,

Analszes Sef Test -] Analeer Se¥ Test

Verification Cartridga Id- |40 Manufaciured Dale: | 01113/2015 | Varification Carridga Id- | 40 Manufactuted Date:  01/13/2015
EIIGHO Loty Fimwaro Compativisty [, ©2==od
Power Supply Vltage Power SupptyUoiiage [ oo
US8 Conmusicaton Rate USH Communcation ot [ e
MGG Hote Motion Home: | Passed
atin Uppar L imits Malion Uppor ini- [ F:so!
Motk ses 3 Molion Prescan | Passed
Mation Posktion Motion Position | Passed
Maion backiash Maiton Backinsh | Pessod
CRONE LN o , Camera Framne Rate [ 1-assod
PCOIS oc orsot I, 5ot
Premsnce Preunaiics | P
ot Pate Heater ol Pt et | e
Lawhoas Lasor Hoator [, o5t
Fase Pastin | Focus Posiion | Posod
Lasor Positon 1 Lasor Posiion. [ ==
Faser PosceRELY Lasar Powcr RFU. [ Fas=ad

Scan barcoda on Verification Cartridge, place into Clla and select Start o begin. | sum | [ sawo
. N
B R HT R AR B 5 B AR
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1. 4 L Cell supernatant: B0 £ITIE, T LB RE D EFHEES -20°C, BER
GRgh. A ME S HY (SST) , FZEKEI0, 4 HEE, 4)51000 x g& &
A #1544, 72100015 8 3% B A o

2. tiESerum: A MLE R HE (SST) , FEiRMEIOpoh fEAF R AR, 4/F1000xg
1504, B MEH LI LI RE A EFHAS -20°C, BRRE R

3. i Plasma: £ F AT & SEDTATE y ok o fl e & fn K o 72 4K & 30444y, 1000 x g%
16574, SLEI SIS H o TS -20°C, BERE K.

HE  FENBLITENHFELELHT LR,
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FE i foxt A R R R R ER T, TeEAEFREY.

2. RBEENETH, FHUNEES, WERRKEZMIK. B850 %K kBRI F&
I T-80°Cok AR FF24/N B A b, BRI — SORFAT U T HI&, DARIES K E — B
Mo

3. MERER WS LBAENERETMAN L FERHETHE. TERESE
RSN RENE, REZERRERTRYL5-3004, EEFEHR
130440, T T Vortex. W FEFIR, X THE5 H14528138HIL-6, AA570 pLHy
SDI3#ATE &, Bk K IR JE K 66300pg/mLay ik .

Analyte Part Number Lot Number R\‘?&%rr"fgttﬂi?)n Coyger?llt?gtli on
IL-6 894968 1452813 570 66300 (pg/mL)

A, FFI XN AR BT AR B B33 (RBAFFFICCL8AL) , B b & 4 &t TAE
W, FAHQCHK Fo JH AR AE & BB EHQCH: 4 # B 501 (RITACHH) , B N 1K 45
d TR, ALQCKR. T AR

Table 1. Preparation of High Controls Table 3a. Preparation of BAFF/CCL8 High Controls

NUMBER VOLUME OF EACH VOLUME OF SAMPLE HIGH CONTROL  VOLUME OF CONTROL  VOLUME OF SAMPLE
OF UNIQUE CONTROL CONCENTRATE  DILUENT TO ADD TO DILUTION CONCENTRATETO ADD ~ DILUENT TO ADD TO
CONTROL TO ADD TO MAKE HIGH  MAKE HIGH CONTROL EXCEPTIONS TO MAKE HIGH MAKE HIGH CONTROL
CONCENTRATES CONTROL (L) (uL) CONTROL (1) (1)
1 120 3880 BAFF 30 3970
2 120 3760 celLs 40 3960
3 120 3640
4 120 3520 Table 3b. Preparation of ITAC Low Controls
5 120 3400 VOLUME OF ITAC HIGH CONTROL OR SAMPLE
6 120 3280 DILUENT TO ADD TO MAKE LOW CONTROL (uL)
7 120 3160 High Control 40
8 120 3040 SD16 3960

Table 2. Preparation of Low Controls

VOLUME OF HIGH CONTROL OR SAMPLE DILUENT TO ADD TO
MAKE LOW CONTROL (pL)

High Control 80
SDXX 3920

(XX=Diluent type*)
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1 MEGEFEERITY, FE4FE Kt B, &/ Kit #, — /Mt ey <& (Cartridge)
— X L By BE 5 A% B R (Sample Diluent 2.4 Reagent Diluent) f2 1-2 #f 3 (Wash buffer) o

EHFEENFAW DN TREL ) H R EREd L, ATRENSRE. WREFE
B AT 2 W ATy SR Ttk 9 BAT R i & 0k 94 0, FTAR#E Cartridge Lot CoA U # i Curve
Data # 474 £ i % o
3. #l4n IFN-g 3rd gen Ji A i % B FOR B 22 o B B 10 B0 4 % — Medh &, I STD.L %
T, RERAHE 256, £ 12/ Mrd B, FERTR:
4. TR, BV R ERHIATEE, D RAT b oA

Performance Data

Analyte LLOQ uLoQ Unit
IFNg 3rd gen 0.17 4000 pg/mL

Curve Data

Known Std.
Id Concentration Measured RFU Concentration %CV % Recovery
(pg/mL)
STD.1 4000 2048.72 5.8 94
STD.2 1600 1335.87 6.3 113
STD.3 640 628.39 4.5 107
STD.4 256 248.68 6.1 98
STD.5 102 97.67 7.3 96
STD.6 41.0 38.23 3.6 96
STD.7 16.4 14.96 94 97
STD.8 6.55 6.16 25 102
STD.9 2.62 2.51 9.0 105
STD.10 1.05 1.05 10.3 108
STD.11 0.42 0.44 8.7 103
STD.12 0.17 0.22 10.3 98

3.2016 £ Genentech Wy #F % %k B, £ & W & 8 Barcoded Curve 5 A I F 5 % #| External Curve
BEES, LR, WAEXANERYE, TRITUFTEEZRRA, BT UHLLR S
B, ReIfExnE, dTAFERELRN, DT UBALGRFIMEHNELEZRFT RALNIRZ,
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Bioanalytical qualification of clinical biomarker assays in plasma using a novel multi-analyte Simple Plex™ platform BioAnalytical
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100 |
w 10—
1 —
T
01—T— T T T 0.1 — T T T
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Sciences, Oncology Biomarker Development Genentech Inc, South San Francisco Bioanalysis (2016) 8(23), 2415-2428
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1. Zif: £HA4 C kAR EEIRKAE, FFEEHBRAETZERER, FHAKEEZ TR
%Rl

2. FAEMAERRE, TEREE, WiREA, 1600095 w4544, DL E T AR/ LR
T, R BT AR

3. BER AR RIER A A BB F (Specification Sheet), | & 7 & 1 it #9 B8 & # B i)
HREFENHFELHATERNHE. HETUXRABILFERIZECE. 5T EE
RO T ES R

Sample Preparation Sample Preparation

Serum and plasma samples require a minimum 2-fold ~ Serum and plasma samples require a minimum 10-fold
dilution with sample diluent. Samples above the ULOQ  dilution with sample diluent. Samples above the ULOQ
require further dilution. require further dilution.

Wi 2R, DA I 35UL Y A 5 A\ B 5Ly A & AR P ik 104,
2P T 7L BE S A\ B 63 LBy A B

4. miEffiER: ARAEFRYEF8, BMREREW (F_4£4%EH) , &
WHPVCRIP BT (T oMK , KB A &I S0uLin X\ B A & 7L
(REMHFRTRA AR, —A3T, AREARFMUEMNTHIEZEA R LK
WEFAMI, T ERERI) o A RFFHHQC/LQC, [ 450 ULz #
Ao B o L R R & IR .

5. Awitik: EImL Wash bufferfie \A% B 7 89 e LA, B FFIE B8 % 7 4 Ao

@ RDsvsrens
RDsystems abiotechne beand @ RDsrsrems
abetechreband | | G 0 0 ) W " W JEnrm . abstechne band
C WK ) « D T
o000 0000 0000000
C — — C N EENE .-
T e
| |G

D G 0 000000
00000000 'REEXEEKLIEE
( 4 ) 20000000

| D

o000 0000
(B ) HEEEEEE.
o000 0000 o000 0eee
( ) - D G

EUILELE
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file Settings Tools Help Demo Mode Enabled

e ki . pokind
Inlet Assignments NeW Klt pI'OtEIn S|mp|61

Confirm Selections

Running Assay 1) Scan Kit Ba i
Running Scan
Kit Results Use Demo Barcode
Lot Number
Expiration Date
Cartridge Type
Analytes
Species Type

2) Scan Cartridge Barcode

Cartridge ID =)
\ﬁﬁﬁﬂ’ﬁﬁ P E

3) Confirm or Change Output File Name

Kit Results File Name | | 3 chanse

Please scan kit and cartridge barcodes before pmceedi@

3. I XA F R HEAE, R Next>, 3t Alnlet Assignments i (40 T E), & ¥ DT
Shift s, # Ctrl = # Select All* % 4 317 4 %
a) Sample Type: £l # f: 26 #Unknown, #7724 1| 2k #¥Standard, Jit 42 & U % 4%

Control
b) Dilution Factor: #n R AN £ & 2 L1, W K2, wREZ1LIHE, Nl x10;

Ao h AR A L

ProteinSimple « Unit 1901, Tower 3, Raffles City Changning Office, 1193 Changning Road, Shanghai 200051 « T 4000 863 973 « proteinsimple.com



bietechne

protein@

Flle Settings Tools Help Demo Mode Enabled
New Kit 3 i i
e | Inlet Assignments proteinginglsls
Confirm Selections TFNg 1L-2r3 -6 TNF-3
Running Assay Inlet  Sample T... Sample Name D) Known Conc. | Known Conc.  Known Conc.  Known Conc. | Comments
Running Scan 1 -@

Kit Results 2| Unknown
3| Unknown 2
4| Unknown 2
5| Unknown 3
6 Unknown B
7| Unknown 2
8| Unknown 2
9| Unknown 2
10 Unknown 2
11 Unknown 2
12 Unknown 3
13| Unknown 2
14 Unknown 2
15 Unknown 2
16 Unknown 2
4 Inport Hor (et ]y, seleet | [Aoay  |[@raste | [ Beverse | [Xolew | oS Etandard Redo Q@
Cartridge Ct \
Assign Inlets and proceed to next step __.

4. &ALV DLAR AT B2 —MExcel, fESample Named#% i 75 2%, K&y (WTH, &%

BAL-ALS) , FfEctrié T, 4 FAFH IS /B0, B84 A Runnersi (i &
B R F MR inlet, BUARTRERLER) , ETHRESS. ST %

AR B AT 45 R J5 # L Explorer 3k 4 4 B4 & 12 B

iR
File Settings Tools Help
New Kit -

Inlet Assignments

Confirm Selections Al -
Running Assay Inlet ' Sample T... Diution Fa... | 4 A |B] G
Running Scan 1 Unknown 2701 [Serum A
Kit Results 2| Unknown 2| 2 |serumB
3 Unknown 2| 3 [serumC
4 Unknown 2| 4 |serumD
5 Unknown 2| 5 [serumE
6 Unknown 2| 6 [serumF
7 Unknown 2| 7 |seum G
8 Unknown 2| g |SerumH
9 Unknown 2| g |serum)
10| Unknown 2| 10|Serum K
11| Unknown 11 |Serum L
12| Unknown 22 [Serum M
13| Unknown 2 ‘1%_ igh QC
14 | Unknown 2114 QcC
15 Unknown 2 15_%
16 | Unknown 2 1E Low QC
17 | A
18 |
19 |
20 |
ek ]

5. FiHfs RAELRE, K& Start BATEK, —KET 78 24
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Simple Plex

sl File>Load Kit % A\ fF 217 8y 214 (.cydat=®# .ecydati X8y X ¥, f&
# %21 CFR Part 11 support Activated &3 T 4 & 8 B %8 X ).

2. WRIBATEIZH, HAX Inlet Assignments ¥EAT 4, & DL s A L Hy Edit
MHHEFTBHEE T, UHEFERIEE,
AU E RS HGERITLE, B2 FHELEFRNERLURET R

4, WRFEBRESHFURERTREGTTRUNEETE, NWZESRNNEEW M EE

*0.220

5 (KTUESEAM: 0% | HFUfE5EHN:

20183
323569* )

, RAZRERTER

B, ZUBREAEEL SR mEL, ATELCTAETEN

5. F32X8Hy k&4, H Atk A Bk & &N Channel# d13/™ % BF B GNR 4L &, #k &M &
HANBARER, R LN RALERNHUCONRE FHM. G URE LT TR
MRS 5 1 & B GNR /S %

{3 simple Plex Explorer
File | View Tools Help
Settings

-v35010 - o X

B P —— Encrypted  Flename Run Date User Specimen Typels) Species Type Lot Number  Car| Sected K&
( lodKitt) BALEH No DABBIESN\ESTH  Bla demo\Ki079632 530 cydat 05/30/2019.. Bla PlasmaSerum Human 6423 79 | Sae
3 Load Curve(s) Save As
RecentKit Resuts > munsEe ]
Recent Curves Remove
Login Save Al
Bt CieQ Remove Al
< > Expat Kts
. . View
Kit Id: 79632 - Cartridge Id: 79562 ®
@ Results Summary
Analytes: OPN O Iriet Assignments
Comments O Calibration Curves
52 82 2 v 5613 108 20501 L4 ERFURNCVETEENRE, IINEER
53 53 2 - 42060 005 329637 0.1 FRREREZIEEEAR, UREES
1 5454 2 - 20818 144 94580 201
55 55 |7 1-RFU: 198.35, Conc: 83844
% % V! 2-RFU: 211.18, Conc: 96477
¥ 3-RFU: 205.18, Conc: 92683
57 57
58 58
59 59
14 14 3 27322 125 141839 2.q
15 15 3 v 25076 75 124576 1 Use Smple Stiadecd Devistion it 8 k3 B, s A L
16 16 3 15186 5 62654 4.4 SetResult Waming Highiighting To  » | [Use Fitter Setting
17.12 00,70 29 A Factory Curves ’
P K wpY Factory | Use High RFU CV -
or GNRs By |8 [+ Addtional Options Use High Concentration CV Eot

Use Filter Setting

6. ETH#ENBEER, BHUNEMHFEZ—ANColumn, B RMBZETH#THTF, WTHE
it AR R B By CVIE 3 K B & 7
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Kit 1d: 86035 - Cartridge Id: 96456

Analytes: IL-6

Comments

L6
Iniet Sample GRs  Mean RFU RFUCY  Mean Conc. (pgiml)

> 21 HMN4SE17 3 v 013 1.06 111 1160 :
4 STD4 3 v 4583 196 345 213
10 STD10 3 v o028 238 161 281
15 HQC1 3 v 18329 2.04 1826 2.89
20 HIN4SE15 3 v o013 24 *1.23 3.62
s STOS 3 v 2105 R 151 3.8
9 sTD% 3~ 082 3.65 388 3.85
23 HINSSE19 3~ 043 3.75 522 418
22 HMNSS618 3 ~ 019 3.32 198 4.28
2 STD2 3 ~ 204.60 3.02 2141 4.42
40 HVNSST 3 * 022 3.54 232 4.92
1 STb1 3 ~ 330.09 232 4824* 4.64
42 HINSSTR2 3 > 014 3.35 *1.27 484
34 HMN4ST14 3 * 013 4.35 e X - | 6.34
16 1QC1 3 v 544 6.41 374 6.57
24 HVIN4S620 3 o~ 012 453 *1.05 6%

i~ 157 7.19

7. ,mﬂ;—%‘(f—%fﬁ # iy Calibration Curves %‘%VJ%?}‘T/&%& (Barcode Curves) , W
HArr, #EpmBakr, MEWEEAEERT, RERAREERT. 74, K
KREEWEREELRERAELM, WwAnalytesH1L-6, LLOQ=0.7pg/mL,

ULOQ=2652pg/mL.

Kit Id: 86036 - Cartridge Id: 96460 e
O Resuts Summary
Analytes: IL-6 iet A 5
Comments: EEFNERH @ Caltration Curves
Parameter Value 16 10/29/2019 PlasmaSerum s
Analyte L6 10000
Factory Curve Yes
Factory Curve ID 9346
Create Date 10/29/2019 1000 =
s 0.04 I —
b 0.99 /
¢ 974,54 P
d 722.67 100+ /
< LoQ 0.700 e
2 4
woQ %52 2w : )/
(I“G >
1 ‘/ e
o
o
¢ 'G—Q—N
01 /@_&,ﬁ" =
—_— Standards
Spies

' ' | f
10 100 1000 10000 20000
Concentration (pg/mL)

8. kA, & BT K Export Kits, 73 H 69 X EAE A FRE A H A

%, w4 AGNREYRFUME (Relative Fluorescence Unit #ﬁﬂi%ﬁ‘tifl) H 45 NGNRW K &
M. 7 DL I R4 T A B9 Exportié 2 B 77 & PDF = 3 3 1t LIMS 3 4T 247
< GenericLIMS . ToLIMs |

T
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Export Kits
Fiters
Start Date Sample Type
Toesday . (RSN 29. 2019 4 (Not Specfied)
[ Control
Standard
End Date [ Unknown
Tuesday . October 29.2019 |
Fnse Specmen Types
(%]E3 [ PrasmaSenm

Kis

4] 86036 (10729/2019 2:33 PM)

DetectConcentration
DetectName

Diventid
DitedConcentrationStatus
Grr1Background

| Gre2Background
Grr3Background

GrrCount

GreFiter
GrrFiterCVPercent Threshold

InletComment
IsSampleStdDev
KeGuid

Ktid

KnownConcentration

KnownConcentrationEnteredUnits
Number

biotechne | @

9 WwmEFARFARBEWFLERBATLE TAVENL, FTULHE | @ smeerecspoe-vison
7t Tools>Build a Curve & jk 3 #y External Curve

File View | Tools | Help
2 | BuildaCurve
§ Analte Export Kits
< |16 )
= Apply Curves to Kits

10. A W e H ey B P AR S J R NS B, S E R ARl S TR A, R

FEREWBET

RFU

a
Build a Curve
g 1) Choose Analyte l Curve Points
g e 6 AFEEEL v [ b Dhwonfactor KnownConcerwaon RFU  Concentraton % Recow
1 Hoe0ss 1 1 663000 3009 7060 10648
AZ)MKnFihsmUsc Hee0ss 2 1 265200 0460 2700 10181
g (486035 3 1 1061.00 10695 1062 100.07
[ C:\Users\Yari\Desktop \Ke 086035 cvdt | | (] as0as & 1 42400 458 8 9141
SRR E Hos0s 5 1 17000 205 166 9766
FEaTE Eee035 6 1 6790 37 741 10920
Fes03s 7 1 2720 39 287 10562
< >||Edee0s 8 1 1090 157 1m 10183
= — |R w05 9 1 N 062 an 5498
E4 86035 10 1 17 028 17 944
3) Check Curve Files to Use | 48035 11 1 (k] 015 0763 10965
p Mesos 12 1 028 007 0277 8%
AR A P AR & R
4) Apply Filtering (optional)
Specinen Types ~
PlasmaSerum
TEERNEMER
Kt Ds
[FEEE—
TEK®S
12 point(s) available <
6) Entor Comments and Save  Commerts [Edemal Cuves  ZF {442

[= IS
s
10000 -
1000
100+
10+
1
01
001, ' ' ' ' ' ' '
001 01 1 10 100 1000 10000 1E+05
Known Concentration
Curve Ft Curve Weightng 1772 mﬂlﬁi
Save Cancel

1Kits Loaded | No Curves Loaded

11. 4k /& B F:Tools>Apply Curves to Kits, E#7 4 K4 | [3 simple plex Explorer - v35.0.10

B &N AT ER, R UL E T

R

File View | Tools | Help
2 Build a Curve t
§ Analpte Export Kits
e |6
~ | Apply Curves to Kits
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12 WFEAR, S5 % EEH M 4R >4 %IE £>Apply to Checked
Samples>Update KitsE[ ¥

{ Fil Apply Curves to Kits o %
12 11) Select Analyte Check Al | | Uncheck Al Sample Points Reset Checked
‘g Anayte | IL6 v | KelD Inlet Sample Type  Sample Name Diution Factor RFU Concentration Known Concentration  Specimen Typefs) Species Type  Captur
F? 186033 1 Standard  STDO1 1 31898 6484 6630.00 PlasmaSerum  Human
[ 86033 2 Standard  STDO2 1 191.06 2416 2652.00 PlasmaSerum  Human
jigg 2 siect Guve 186033 3 Standard  STDO3 1 10332 1016 1061.00 PlasmaSerum  Human
| cuve Fie [ \Deskiop\IL6_20200220_112657. ~ |Oss033 4 Standard  STDO4 1 4547 384 424.00 PlasmaSerum  Human
[186033 5 Standard  STDOS 1 1907 149 170.00 PlasmaSerum  Human
[]86033 6 Standard  STDOG 1 83% 628 67.90 PlasmaSerum  Human
3) Check Kits to Update | A None []86033 7 Standard  STDO7 1 33 27 2720 PlasmaSerum  Human
(186033 8 Standard  STDOS 1 131 918 10.90 PlasmaSerum  Human
] 86035 []86033 9 Standard  STD09 1 05 328 4 PlasmaSerum  Human
186033 10 Standard  STD10 1 023 13 174 PlasmaSerum  Human
186033 11 Standard  STD11 1 o1 053% 070 PlasmaSerum  Human
186033 12 Standard  STD12 1 008 029 028 PlasmaSerum  Human
[ 86033 13 Control  HQC1 1 16865 1991 PlasmaSerum  Human
(186033 14 Control  LQC1 1 481 354 PlasmaSerum  Human
Apply Filtering (optional 186033 15 Unknown  NSB 005 PlasmaSerum  Human
4 r::' ! ) . | O 8e033 16 Unknown  NSB 008 PlasmaSerum  Human
_ 186033 17 Unknown  HMN4S613 2 010 0891 PlasmaSerum  Human
(186033 18 Unknown  HMNASE13H.. 2 13666 2943 PlasmaSerum  Human
[]86033 19 Unknown  HMNAS6132.. 2 017 181 PlasmaSerum  Human
186033 20 Unknown  HMNAS614 2 008 0602 PlasmaSerum  Human
[ 86033 21 Unknown  HMNASG14-H.. 2 14012 3047 PlasmaSerum  Human
186033 22 Unknown  HMNAS6142.. 2 018 204 PlasmaSerum  Human
186033 23 Unknown  HMNAS615 2 003 0783 PlasmaSerum  Human
Capture Names []86033 24 Unknown  HMNASE1SH... 2 14607 3230 PlasmaSerum  Human
186033 25 Unknown  HMNAS6152.. 2 o1 15 PlasmaSerum  Human
[]86033 26 Unknown  HMNASE21 2 003 0788 PlasmaSerum  Human
[]86033 27 Unknown  HMNASE21-H... 2 12952 2734 PlasmaSerum  Human
186033 28 Unknown  HMNAS6212.. 2 017 181 PlasmaSerum  Human
186033 29 Unknown  HMNAS622 2 012 112 PlasmaSerum  Human
186033 30 Unknown  HMNAS622-H... 2 14382 3160 PlasmaSerum  Human
s i v | 86033 31 Unknown  HMNAS6222... 2 020 229 PlasmaSerum  Human
(186033 32 Unknown  HMN4S623 2 0039 0825 PlasmaSerum  Human
(186033 33 Unknown  HMNAS623H.. 2 1875 2434 PlasmaSerum  Human
5) Apply Selected Curve 186033 34 Unknown  HMN4S6232.. 2 019 210 PlasmaSerum  Human
[]86033 35 Unknown  HMN45713 2 006 0322 PlasmaSerum  Human
I Toshy %o Chacked Samgles>> | 186033 36 Unknown  HMNAS7I3H.. 2 7536 1377 PlasmaSerum  Human v
< >
Selected Curve Detads
Specmen Typea): PlasmaSenum Unts:pg/ml. Comments: Extemal Curves 6) Update Kit Results Filos Cancel

3 Kits Loaded | 1 Curves Loaded
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1.4 2 4], %9 pLE S https://www.bio-techne.com/resources/simple-plex-panel-
builder
i 3 T AR AR OK 3 5 A3 BB & BB (mHuman), BE S 3K A (e da il _E 0 ) Fr A AR 1 B T T (e
IL-6), {8tk 2 igpanel 4l & K %5

Load an existing cartridge configuration Panel Builder Summary

Please sign-in to load or save your selections. When you click the link, you'll be taken to the sign-in page, then
P 2 Y ; s < < = pag Species: Human

Sample Type: Cell Supernatant

Panel 1 Analytes:

Dilution Factor: 1:2

brought back here to pick-up where you left-off

1.IL-6 2nd gen
Make your selections below to configure your assay. Learn more about Simple Plex Assay Configurations

Species
View Panel Details
| Human VI
Sample Type
l Cell Supernatant V]
Analytes

[| ] Clear Selections

Select from the list below to configure panels of up to 4 analytes.

Our team is here to help! Please reach out to your local Bio-Techne immunoassay specialist if you are having difficulty

configuring your assay or are interested in analytes not seen in the menu below.

QAEEFMNPA T F BT AR ZETHIA RS, RIECHFEEE, BESENHTITY
BI P . dnFiF2046T, ¥ 5% X <Simple plex panel builder {# F 457 >
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bietechne | =&
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1. Fa TR https://www.bio-techne.com/resources/cofa-finder-tool

2B M N TEN P g Bt 5, 4n SPCKB-PS-002803, & 17 Next, R4E#R & F A5 40 22621,
% J& Load CoA Bl 7] % i T %o

Certificate of Analysis Finder Tool

Search by Catalog Number

Enter a catalog number

Enter lot number

G [ o]

3THEWzip 46, & FaNERAH MR ERIESN XHEE,

i
BT

L |
Cartridge Kit Product Insert.pdf

Cartridge Lot CoA.pdf

Cartridge Lot Information Zip File Contents.pdf

Control CoA.pdf

Control Insert.pdf

zip_000321_7407.zip - ZIP E4E X4, BBEA/ A 632,492 F15

~
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1.8 F 40 T W3k https://www.bio-techne.com/cn/

2.8 3T 4R HATH E, 4 Simple Plex TGF-beta 1 # %15 #|n F 45 %

Simple Plex Mouse/Rat TGF-beta 1 Cartridge @

Catalog # SPCKB-MP-001191 T‘ Datasheet / SDS

Simple Plex Cartridge Kit containing TGF-b1 for use with Mouse and Rat Plasma/Serum. Includes wash buffer and
sample diluent. For use with the Ella automated immunoassay system
Catalog # Availability Size / Price Qty Order Information

SPCKA-MP-001191 @ In Stock 1 Kit (1 Analyte x 16
Samples) / Please

Bio-Techne China Co. Ltd.
tel: 400-821-3475 (JEA L)

Inquire
info.cn@bio-techne.com
SPCKC-MP-001191 @ In Stock 1 Kit (1 Analyte x 32
Samples) / Please Shipping Information
Inquire Please contact us for shipping
SPCKB-MP-001191 ® InStock 1 Kit (1 Analyte x 72 charges and delivery times
Samples) / Please
E 4) P View Distributors
Inquire

3./ i Download product datasheet, 77 # i &9 P 5| % 7 4 Bl 7T o AZ X, &1L
KGRI KE IR ERERERN, wEER, RMKR, WEACE, HEHEZ, Tl
FRME, EREE,

specification sheet

Mouse/Rat TGF-1, 2nd Generation

Simple Plex assay for the detection of mouse and rat Transforming
Growth Factor beta 1 (TGF-31) in serum and platelet-poor plasma
(EDTA/Heparin)

For research use only. Not for use in diagnostic procedures.

Calibration Curve Endogenous Levels

The factory generated calibration curve shown below Endogenous levels were calculated from multiple
was compiled by averaging 5 replicates of each calibrator samples.
from multiple runs. The 5PL curve fit shows calibrator

MEAN RANGE STD DEV
concentration as a function of signal intensity (relative MOUSE SAMPLES (pg/mL) (pg/mL) (pg/mL)
fluorescent units, RFU). Serum (n=5) 85018 65,642-99.721 12,298
PP EDTA Plasma (n=5) 10,130 5507-12,992 2645
uLoQ B PP Heparin plasma (n=5) 25415 16,344-32,101 7593
1000 —
MEAN RANGE STD DEV
RAT SAMPLES (pg/mL) (pg/mL) (pg/mL)
£ 100 Serum (n=5) 55655 1491-85,661 32823
H [ PPHeparin plasma(n=5) | 14786 | o3o4-1geee | 3649 |
& LLoQ
10 Precision
| Iy
Intra-assay Precision: Each control was tested 16 times
1 in one assay.
1 10 100 1000 10000 100000

Inter-assay Precision: Replicates of each control were

Concentration (pg/mL)
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1. ARFFEAF I E, FHEFEMNHDE AT LD LKER)

2. FEMWIFILTE, BEA+LLRER)

3. RFAMEMHIEE, BEH+T L KER)

Objective Window

Cartridge Nest

4. AR R BEWE R EE K —K)

©® 7 = K5 37 B e B A A

@ Ji F A B R T R R A

O WA FE, TiBEFHREIFINH R ETIRE (PN 541401)

5. RO FEMAR(ERERE, HHBERRPIEMS, #RARERERTH, KEWE
T )

6. BARME : WAL T RAIKS, MG N A AR EFSHATER, BRET T LE;

WRIMFAFIRS, WERLRWAET B8, FHFATET KRBT,

7. BEFH—NEFHREFEE (PN:600-103, Ella Verification Cartridge) 2% # Bt & R 13 473R

JTFEAE (PN:S-600-103-REVA, Revalidation of the verification cartridge)
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